
 

© Keterex, Inc., 2009.  All rights reserved. AN1401-R2 

 

 

AN1401 
Application Note 

 
 
 

KX1400 Development Kit User’s Guide 
 
 
 
APPLICABLE DEVICES 
 
This Application Note applies to the following 
Keterex devices: KX1400EW and KX1400EG. 
 
 
INTRODUCTION 
 
The KX1400 Development Kit provides the 
hardware and software necessary to quickly and 
easily interface the KX1400 Audio Playback IC to a 
PC-based host. The included KX1400 Evaluation 
Board facilitates hardware prototyping and 
development of firmware for microcontroller-based 
designs without the need for PCB design or 
complicated bread-boarding.  The Development Kit 
software provides features for real-time execution 
of KX1400 host-interface commands and the 
acceleration of audio data creation and evaluation.  
Example projects for creating audio data are 
included to assist in familiarization with the 
Development Kit and the capabilities of the KX1400 
Audio Playback IC. 
  

This document discusses initial hardware setup 
and configuration and provides instructions for 
software installation.  A “Getting Started” tutorial is 
included. 
 
 
KEY POINTS 
 
 Development Kit provides PC-based interface 

to the KX1400 via USB. 

 No microcontroller or firmware development is 
needed for initial KX1400 evaluation and 
development. 

 Development Kit supports programming 
external Flash or EEPROM memory. 

 Utilities to assist in the creation and evaluation 
of audio data included. 

 Hardware setup and software installation is 
discussed. 

 KX1400 Evaluation Board provides resources 
to facilitate evaluation and prototyping. 

 

1. Kit Contents 
The KX1400 Development Kit contains the following items: 
 

 KX1400 Evaluation Board 
 Keterex USB Adapter 
 Keterex KX1400 Software and Product Information CD-ROM 
 USB Cable 
 KX1400 Quick Start Guide. 

 
 
The KX1400 Evaluation Board is populated with the KX1400EG (24-pin 4x4mm QFN).  However, this 
development kit is applicable to both the KX1400EG and KX1400EW (20-pin SOIC) devices.  
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2. Setting up the Development Kit Software 
The Keterex KX1400 Software and Product Information CD-ROM contains: 
 

 KX1400 Integrated Development Environment (IDE) application 
 Keterex Macro Language Processor application 
 A WAV-to-ASCII C include file encoder application 
 Device driver for the Keterex USB Adapter 
 Example audio projects 
 Optional Third-party Software: 

 Audacity Digital Audio Editor – open source digital audio editor distributed from 
SourceForge.net 

 Uninstallers for the KX1400 IDE and Audacity  
 Product Information 

 KX1400 Datasheet and Application Notes 
 KX1400 Software User’s Guide 
 Keterex Macro Language Processor Reference Manual 
 Keterex WAV-to-Include Reference Manual 

2.1. System Requirements 
The following minimum system requirements are necessary to use the KX1400 Development Kit software 
and access the installed product information: 
 

 Pentium-class host PC running MS Windows XP (SP2 or later) or Vista 
 512 MB RAM 
 CD-ROM drive 
 One USB port 
 110MB free HD space 
 Adobe Acrobat reader (v7.0 or later) 

2.2. Installing the Development Kit Software 
To install the Development Kit software and documentation, insert the CD into your PC’s CD drive.  An 
installer should automatically launch.  Follow the on-screen prompts to select the desired installation 
configuration.  If the installer does not automatically start when the CD is inserted, run Setup.exe from the 
root directory of the CD drive.    During installation you may see the following dialog window.  If so, click 
“Continue Anyway” to continue the installation.  (On Vista systems, click “Install this driver software 
anyway”.) 
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When the Keterex USB Adapter is first connected to the PC, the following dialog window may appear.  If 
so, select “No, not this time” and click “Next” (The dialog on Vista systems is different but similar.)  
 
 

 
 

 
After clicking “Next”, the following dialog will appear.  Click “Next” to continue driver installation. 
 
 

 
 

Click “Finish” on the final dialog to complete the installation of the Keterex USB Adapter drivers. 
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2.3. Un-installing the Development Kit Software 
The KX1400 Development Kit software can be easily removed from the PC on which it was installed.  A 
utility to remove the Development Kit software is installed as part of the Development Kit.  All files and 
subdirectories in the target directory to which the Development Kit software was initially installed (typically 
C:\Program Files\Keterex\KX1400) will be removed. 
 
The KX1400 Development Kit software cannot be un-installed using the Windows “Add or Remove 
Programs” control panel; you must use the un-installer provided.  The icon to launch the uninstaller utility 
(kx1400_uninst.exe) is labeled “KX1400 Development Kit Uninstall” and is located in the same folder in 
the Start Menu as the KX1400 Integrated Development Environment icon.  
 
To remove the KX1400 Development Kit software: 
 
1. Double-click the “KX1400 Development Kit Uninstall” icon.   
 
2. Click “Uninstall” on the “Confirmation” dialog. 
 
3. Next, you are prompted to remove the Audacity Digital Editor application.  You can remove the 

Keterex Development Kit application but leave Audacity installed if you wish.  To remove Audacity at 
this time, click “Yes” and then “Yes” again on the “Audacity Uninstall” dialog; otherwise, click “No”.   
You can use the Windows “Add or Remove Programs” control panel to remove Audacity at a later 
date. 

 
4. Click “OK” on the Audacity confirmation dialog and then click “Close” on the “KX1400 Uninstall: 

Completed” dialog. 

3. Setting up the Hardware 
The KX1400 Evaluation Board is connected to a host PC via the Keterex USB Adapter as shown in 
Figure 3.1.  The USB Adapter converts USB transactions to the KX1400 host interface protocol and 
provides power to the KX1400 Evaluation Board.  No additional power supply is required. 
 
 

KETEREX
USB Adapter

J5

J1: Short 
[VUSBIF] Pins

J2: Short 
[HST-CTRL] Pins

J6

J8: Host I/F
Connector

To Speaker or 
HeadphoneUSB Cable to

to PC USB Port
 

Figure 3.1 Hardware Setup 
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1. Connect the Keterex USB Adapter to the Host I/F connector on the KX1400 Evaluation Board.  The 
connector is keyed to the ribbon cable of the USB Adapter to ensure correct polarity. 

 
2. Connect one end of the supplied USB cable to the USB connector of the Keterex USB Adapter. 
 
3. The other end of the supplied USB cable can be connected to any available USB port on the host PC. 

However, it is recommended that you do not connect the USB cable to the host PC before 
installing the Development Kit software (see Section 2.2). 

 
4. Ensure shorting blocks are installed in the [VUSBIF] position on J1 and the [HST-CTRL] position on 

J2.  (This is the default configuration from the factory.) 
 
5. Connect user-supplied headphones or a speaker to the KX1400 Evaluation Board using the 3.5mm 

(1/8” mini-plug) stereo audio jack (J5). (External PC speakers work well for this purpose.) 
 

- If using headphones, install a shorting block in the [HDPHONE] position on J6 (factory default). 
 

- If using a speaker, install a shorting block in the [SPEAKER] position on J6.  The KX1400 is 
designed to optimally drive a 0.25W 8Ω speaker.  However, external PC speakers can be used 
and typically work well for initial evaluation. 

 
Note: While the output of the KX1400 is monaural, the audio jack (J5) is wired to accommodate 
stereo plugs; it sends the same signal to both channels.  Ensure the plug connecting the speaker or 
headphones to the J5 audio jack is a standard 2-channel (stereo) plug.  A mono plug will short the 
positive and negative audio outputs of the KX1400 IC together. 

4. KX1400 Integrated Development Environment 
The KX1400 IDE provides an interface for developing KX1400 audio files and for the real-time execution 
of KX1400 commands and audio phrases from a PC-based host.  The IDE alleviates the need for a 
microcontroller and firmware for initial evaluation.   
 
When the KX1400 IDE application is launched, it automatically connects to the KX1400 Evaluation Board 
through the Keterex USB I/F Adapter.  If unable to make a connection, it will continuously monitor the 
status of the USB Adapter and establish a connection automatically as soon as it is able.  The current 
status of the connection between the host PC and the KX1400 Evaluation Board is indicated in the lower-
left corner of the IDE window.   
 
Refer to the Application Note “AN1402: KX1400 Software User’s Guide” for more information.  This is 
available under the “Help” menu in the IDE. 

4.1. Getting Started 
1. Connect the Evaluation Board and USB I/F Adapter to the host PC as discussed in Sections 2 and 3 

and launch the KX1400 IDE.  The indicator in the lower-left corner of the IDE should indicate 
“CONNECTED”.  If not, try disconnected and reconnecting the USB I/F Adapter to the host PC. 

 
2. To open an example project, click “Open Project” under the “Project” menu and navigate to and select 

“Examples/Example1/example1.kpj”.  The example projects are located in the 
“My Documents\Keterex\KX1400\Examples” directory by default (under Vista, look for “Documents” 
rather than “My Documents”).  

 
3. Build the example project by selecting “Build Selected File” (or click the  toolbar button).  The 

“Messages” pane at the bottom of the IDE window will display the status of the build. 
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4. If no errors are reported from the build, select “Download Build Results” from the IDE’s “Project” 
menu (or click the  toolbar button).  This will program the audio data to the external Flash memory 
on the KX1400 Evaluation Board and populate the phrase list in the IDE’s toolbar. 

 
5. To play a phrase (a sequence of audio commands/data), select the phrase’s name from the selection 

box and click the  toolbar button. 

4.2. Example Projects 
The KX1400 IDE, the Macro Language Processor and included audio editing utilities make it easy to build 
commands and sampled audio data into audio “phrases” and then download those phrases to the 
KX1400 Evaluation Board for evaluation and debug.  Example projects are copied to the 
“My Documents\Keterex\KX1400\Examples” directory when the IDE is first launched to assist you in 
exploring the power of these tools. 
 
Refer to Applications Note “AN1402: KX1400 Software User’s Guide” for additional information on the use 
of the tools and these examples.  This document is available under the “Help” menu in the IDE. 

5. Evaluating the KX1400 in Stand-alone Mode 
The KX1400 supports operation in a stand-alone mode that does not required connection to a host 
controller (refer to the KX1400 Datasheet for more information on stand-alone operation).  To operate the 
KX1400 in stand-alone mode: 
 
1. With the shorting block installed in the [HST-CTRL] position on jumper J2, download a project with 

one or more complete audio phrases (sequence of commands terminated with a STOP command). 
 
2. Move the shorting block installed on jumper J2 to the [ST-ALONE] position. 
 
3. Press and release the RESET switch.  The first phrase in the external memory is retrieved and 

executed by the KX1400.  Execution of the first phrase in memory will be repeated each time the 
RESET switch is pressed and released. 

 
4. Return the shorting block to the [HST-CTRL] position on J2 to return the KX1400 to host-controlled 

mode and enable downloading and command execution from the IDE via the USB Adapter. 
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6. KX1400 Evaluation Board 
The KX1400 Evaluation Board provides numerous resources and connections to facilitate the evaluation 
and prototyping of both audio data and hardware designs.  Figure 6.1 shows the locations of the many I/O 
(input/output) connections. 

KX1400

External Memory

J5

J1 J2

J3

J4

J6

J7

J8

Reset Switch

Power LED GPO1 LED
GPO2 LED

Host Interface

(+) Battery Terminal

(-) Battery Terminal

Auxiliary I/O
Pin 1

 
 

Figure 6.1 KX1400 Evaluation Board 

6.1. J1 (Power Selector) 
The J1 jumper is a 3-pin header used to select the power source for the KX1400 evaluation board.  
Installing a shorting jumper on the pair of pins labeled [VUSBIF] selects the USB Adapter via the host 
interface as the power source.  Installing the shorting block on the [VBATT] pair selects an optional 
battery as the power source (see Section 6.11). 
 

6.2. Jumper J2: Mode Selector 
The J2 jumper is a 3-pin header used to configure the KX1400’s operating mode. Installing a shorting 
jumper on the pair of pins labeled [HST-CTRL] configures the KX1400 to operation in host-controlled 
mode.  Installing the shorting block on the [ST-ALONE] pair configures the KX1400 to operate in stand-
alone mode.  Refer to the KX1400 Datasheet for more information on the host-control and stand-alone 
modes of operation.  The datasheet is available under the “Help” menu in the IDE. 

6.3. Jumper J3 (GPO2) and Jumper J4 (GPO1) LED Connections 
The J3 and J4 2-pin jumpers can be used to connect the KX1400’s GPO1 and GPO2 outputs to LEDs.  A 
shorting block on the J3 jumper connects GPO2 LED to the KX1400 GPO2 pin.  Installing a shorting 
block on J4 connects the GPO1 LED to the KX1400’s GPO1 pin.  The LEDs are illuminated when their 
associated GPO output is in the logic-low state. 

6.4. J5: Audio Jack 
The J5 connector is a 3.5mm (1/8” mini-plug) stereo audio jack used to connect a speaker or headphones 
to the KX1400’s audio output. The KX1400 is designed to optimally drive a 0.25W 8Ω speaker.  However, 
external PC speakers can be used and typically work well for initial evaluation.  Note: Although the output 
of the KX1400 is monaural, the audio jack (J5) is wired to accommodate stereo plugs; it sends the same 
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signal to both channels.  Ensure the plug connecting the speaker or headphones to the J5 audio jack is a 
standard 2-channel (stereo) plug.  A mono plug will short the positive and negative audio outputs 
together. 

6.5. Jumper J6:  Output-level Selection 
The J6 3-pin jumper can be used to route the KX1400’s audio output through a series resistor to 
attenuate the output to a level suitable for typical low-power (e.g. ear-bud) headphones.  When a shorting 
block is installed in the [HDPHONE] position, the output is routed through a 140Ω resistor in series to 
attenuate the output level.  When the shorting block is installed in the [SPEAKER] position, the output is 
not attenuated.  If a shorting block is not installed in either position, the J5 audio jack is not 
connected to the audio output of the KX1400. 

6.6. Connector J7: Auxiliary I/O 
The J7 connector provides direct access to most of the KX1400’s main I/O signals not readily available 
via the other jumpers.  It can be used to connect the KX1400 to a microcontroller or other circuitry for 
prototyping hardware designs or to facilitate probing during debug. 
 

Table 6.1 Auxiliary I/O Pin Descriptions 
 

Pin # Description 
2 +3.3 VDC 
4 GPO2 
6 GPO1 
8 BUSY 
10 /CS 
12 SDI 
14 SCL 
16 /RDY 
18 /RST 
20 CLKOUT 

1, 3, 5, 7, 9, 11, 
13, 15, 17, 19 Ground (GND) 

6.7. Connector J8: Host Interface 
The J8 connector provides access to the KX1400’s host interface signals.  It is used to connect the 
KX1400 Evaluation Board to a PC host via the Keterex USB Adapter.  The pin layout is designed to mate 
directly to the ribbon cable of the Keterex USB Adapter and the connector is keyed to the ribbon cable of 
the USB Adapter to ensure correct polarity. 
 

Table 6.2 Host Interface Pin Descriptions 
 

Pin # Description 
1 SCL 
2 +3.3 VDC (Input) 
3 BUSY 
4 GND 
5 SDI 
6 GND 
7 /CS 
8 Not Connected 
9 /RST 
10 /RDY 
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6.8. Power Indicator 
The PWR LED indicates power is available to the KX1400 via the host interface connector. 

6.9. External Memory 
A 16-MByte SPI Flash memory (P/N: Spansion S25FL128P0XNFI011) is installed on the Evaluation 
Board and connected to the external memory interface of the KX1400.  It is used to store sequences of 
commands and sampled audio data for playback.  It provides sufficient capacity to store over 69 minutes 
of audio encoded in 8KHz ADPCM format.   
 
The external Flash memory is accessed for programming through the KX1400 when configured in Pass-
thru mode (refer to the KX1400 Datasheet for information on Pass-thru mode operation).  No direct 
connection to the SPI pins of the external memory is provided. 

6.10. Reset Switch 
The switch (SW1) labeled “RESET” is a momentary switch connected to the hardware /RST pin of the 
KX1400.  Pushing the switch pulls the input to the KX1400 /RST pin low (reset state).  Releasing the 
RESET switch allows the /RST input to go high and release the KX1400 from its reset state. 

6.11. Battery Terminals 
The KX1400 Evaluation Board can be powered using a 3.0V coin-cell battery (example: Panasonic 
CR2330) for complete stand-alone operation without any connection to the USB Adapter.  The battery is 
not populated on the evaluation board as shipped from the factory.  Two 0.035” diameter, solder-plated, 
thru-holes are provided on the evaluation board to facilitate user installation of a battery.  The board is 
designed for the battery to be installed on the bottom of the board and the battery’s terminal lugs soldered 
directly to the board.  Refer to Figure 6.1 for location of the terminal thru-holes.  There are no polarity 
markings on the Evaluation Board’s silkscreen.  For reference, the terminal thru-hole located closest to 
the J5 audio jack is the ground (-) terminal. 
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6.12. KX1400 Evaluation Board Schematic 

 
Figure 6.2 KX1400 Evaluation Board Schematic 
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Contact Information 
 
Keterex, Inc. 

7320 N. MoPac Expressway 

Suite 201 

Austin, Texas 78731 

Tel: 512-346-8800 

www.keterex.com 

Email: support@keterex.com 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Information furnished by Keterex, Inc. in this document is believed to be accurate and reliable.  However, no responsibility is 
assumed for its use.  Information in this document is subject to change without notice. 
 
Trademarks: The Keterex name and logo are registered trademarks of Keterex Incorporated.  Other products or brand names 
mentioned herein are trademarks or registered trademarks of their respective holders. 
 
Use in life support systems: Keterex devices are not designed for use in life support and/or safety equipment where malfunction 
of the product can result in personal injury or death. Your use or sale of these devices for use in life support and/or safety 
applications is at your own risk. You agree to defend and hold us harmless from any and all damages, claims, suits or expenses 
resulting from such use. 
 
Limitation of Liability: You acknowledge and agree that, in no event, shall Keterex be liable, whether in contract, warranty, tort 
(including negligence or breach of statutory duty), strict liability, indemnity, contribution, or otherwise, for any indirect, special, 
punitive, exemplary, incidental or consequential loss, damage, cost or expense of any kind whatsoever, howsoever caused, or for 
any loss of production, cost of procurement of substitute goods, loss of capital, loss of software, loss of profit, loss of revenues, 
contracts, business, cost of rework, loss of goodwill or anticipated savings, or wasted management time, even if Keterex has been 
advised of the possibility or they are foreseeable. The total liability of Keterex on all claims, whether in contract, warranty, tort 
(including negligence or breach of statutory duty), strict liability, indemnity, contribution, or otherwise, shall not exceed the purchase 
price of these devices 


	1. Kit Contents
	2. Setting up the Development Kit Software
	2.1. System Requirements
	2.2. Installing the Development Kit Software
	2.3. Un-installing the Development Kit Software

	3. Setting up the Hardware
	4. KX1400 Integrated Development Environment
	4.1. Getting Started
	4.2. Example Projects

	5. Evaluating the KX1400 in Stand-alone Mode
	6. KX1400 Evaluation Board
	6.1. J1 (Power Selector)
	6.2. Jumper J2: Mode Selector
	6.3. Jumper J3 (GPO2) and Jumper J4 (GPO1) LED Connections
	6.4. J5: Audio Jack
	6.5. Jumper J6:  Output-level Selection
	6.6. Connector J7: Auxiliary I/O
	6.7. Connector J8: Host Interface
	6.8. Power Indicator
	6.9. External Memory
	6.10. Reset Switch
	6.11. Battery Terminals
	6.12. KX1400 Evaluation Board Schematic


